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Design Principles 
Goals 
• Overall: The design will  

• be pleasing to the eye, 
• encourage better orders, 
• make filling out the orders correctly easy, and 
• make error difficult. 

 
General Forms Principles 
Though not well-known, research shows that there are good and bad ways to make forms, as 
reflected in the number of errors in filling out or reading a form. The body of this document 
provides many of these details, but a few overarching principles are worth reviewing at the 
outset: 

• Number of pages: There is always an urge to minimize the number of pages for a set of 
orders. But as forms expert Robert Barnett points out, users have an easier time filling 
out forms that, even if multi-page, have adequate room for writing and appear 
uncluttered. What is more, uncluttered forms also have lower error rates. And, 
compared to the cost of a few extra pieces of paper, the time cost of filling out difficult 
forms, not to mention the cost of avoidable user error, far outweigh the cost of 
extending the form to an additional page. 

• Floating Boxes: there are forms with many different types of “look and feel”—tradition 
dictated boxes with black hairlines and 6-7 point Helvetica text in the upper left of the 
box. However, this old style of form has been shown, in good studies, to result in more 
errors than other types of form. In particular, the best is the “floating box” style—where 
all areas that require user input are white boxes on a gray or colored background, and 
captions or other text appear superimposed on the tinted background. 

• Right-Aligned: Studies show that people make fewer errors if columns of checkboxes are 
on the right, not on the left, and the text is to the left of the checkboxes, right-aligned. 

• Proper Size: For legibility and to decrease errors in filling and reading forms, checkboxes 
should be 3/16” in height, fillins should be 5/16” in height, and signature blocks need 
to be 7/8” high. Other recommended formatting principles appear below. 

• Checkboxes: Although called “check” boxes there is evidence that it is much better if 
users put an “X” in the box. Having a graphical illustration of this on the orders is also 
needed—though text instructions to this effect may appear on the form, explanatory text 
is ignored by the vast majority of those completing the form. 

 
Overall Form and Content 
For Mercy forms, and particular for standing orders, the following principles should apply: 
• The same information should always be in the same place. As much as possible, the forms 

should look the same.  Items such as the patient ID space, notes such as about generic drugs 
and lining out orders, logo, headers, date, page number, signature block, should almost 
always be in the same place and say the same thing on all the forms. For forms, familiarity 
breeds, not contempt, but speed and accuracy. 

• Sections should be in the same sequence as much as possible. At least on orders that are 
supposed to replace generic admission orders, a standard format such as the “ADCA VAN 
DIMMLS” taught in medical school will speed users and decrease error.Although these will 
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vary across various standing orders, a fairly generic listing, at least for admitting order sets, 
is as follows: 
• Admit 

• 23-hour admission OR full admission (but note that, for DEM Transition orders, or 
diagnosis-specific standing orders, the hospital would like this determination to be 
done after the initial admission orders are completed, i.e., not at night, and not by 
DEM physicians). 

• To (unit):  
• Attending:  

• Monitor 
• Nonmonitored OR Monitored (originally we said “attach telemetry orders” but then 

realized there are no telemetry orders, so the “attach telemetry orders” has been 
removed.) 

• Diagnosis (surgery type/date for those admitted for planned surgery): 
• Condition: Stable, Serious, Critical, Other: 
• Code Status: Full, Other (attach code status sheet) 
• Allergies: (include reaction if known) 
• Vital Signs: Q shift, Q4H, QID, BID, Other:  
• Activity:  Ad lib, BR c assist, Bed Rest, Ambulate daily as tolerated, Other:  
• Diet:  Regular, ADA consistent calorie, Mechanical Soft, NPO, Other:  
• IV:  PRN Angiocath, Other: 
• Medications (e.g., antibiotics, analgesics, insulin) 
• Labs/Tests 
• Nursing/Ancillary Staff Orders:   

• Admission Weight, Daily Weights 
• Strict Input/Output 
• Baseline functional status 
• Respiratory orders 

• Notify physician 
• if temp > 101°F (38.4°C) 
• if systolic BP <90 or >180 or diastolic BP >100 
• if respirations >30 or <10 
• if O2 saturation <92%  
• if significant change in patient condition 

• Education: (Provide smoking cessation educational materials, Provide CHF educational 
materials, Provide diabetic diet educational materials, Other) 

• Consults: (incl. Home Care) 
• Other:  
• Admission Status: 
• Teaching Status (note: we finally decided to move this information, traditionally at the 

beginning of the orders, to the end, to combine with the final signature block) 
• Nonteaching 

• “These orders by DEM physician; must be verified with attending physician by 
following 9 AM, & signed within 24 hours. Call physician below for changes in 
patient condition, or if further orders needed:” 
• Covering Physician:  
• Notified at (time):  

• Teaching  
• A Firm 
• Z Firm  
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• Subspecialty Medicine 
• Other: 
• Resident 
• Pager 

•  (Discharge Planning to be saved for bottom of “regular” order sheets) 
• Defaults:  

• Most sections will provide checkboxes for common options for each of the following 
(e.g., vital signs Q shift, QID, BID, Q4H). When there is a standard “default” for which 
of these checkboxes one ordinarily check for a particular Standing Order set (e.g., Vital 
Signs BID for COPD orders) this option may be in bold italic.  

• When something should be ordered virtually all the time, its checkbox is pre-checked. 
While the ordering clinician can line-out, date and initial these orders, this should 
happen only rarely. 

 
Design and Construction Details 
• Choice of Software: 

• Adobe Illustrator is the market leader for software that can be used to design forms with 
a detailed graphic design. For example, Adobe offers an “Adobe Designer” forms-design 
software that makes designing electronic forms easy, but does not make the visual 
aspects of form design as easy—it lacks the flexibility of Illustrator. A fair number of 
forms design professionals use Adobe InDesign, which is somewhat similar to Adobe 
Illustrator—but Illustrator has the advantage of allowing “libraries” of preformed forms 
elements that, with the mouse, can be dragged and dropped into position. 

• Although other software may be easier to use, other software does not allow one to 
produce forms of the visual quality that Adobe Illustrator provides—each of the other 
forms package (especially including Microsoft Word) prevents one from implementing 
one or more of the standard recommendations for high-quality forms. 

• Adobe Illustrator is somewhat challenging to learn; however, its expanded capabilities 
more than outweigh this. And, by providing detailed principles (this part of this 
document) and procedures (below), as well as providing a few “template” examples to 
follow, creating new forms is not all that difficult.  

• By providing “template” forms with reusable elements, one can simply copy existing 
design elements into a new form. It becomes simple to use the modular elements of an 
old form to create a new form. And by using a template with a standard grid, and setting 
“Snap to Grid” on, it is easy to align the new elements in a pleasing and standard 
manner. 

• Typefaces:  
• We should use typefaces that are easy to read and reproduce well when printed on laser 

printers.   
• We should put most of the text in an easy-to-read sans serif font. Although Helvetica 

(AKA Arial) is very traditional,  Gill Sans (also known as Hammersmith and Garrison Sans) is 
the default for many medical forms-design professionals. Gill Sans is easy to read, and is compact; 
this is what it looks like in bold and in italic and in bold italic. The Monotype version of Gill Sans 
is more readable than the Digital Typeface Corporation Garrison Sans, so we will be using the 
Monotype font, though a bit more expensive. 

• The typeface Minion, 15-point, is used for the trademark “Mercy Hospital of 
Pittsburgh” and “Mercy” with the dove: it is the corporate standard. 

• We should use a minimal number of fonts and font sizes: Minion and Gill Sans without 
any other fonts. 

• Margins:  
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• Half-inch left, right and bottom margins on all forms, to avoid computer-printer and 
photocopy problems. Note that this includes some room for the form number, which is 
de-emphasized by being in gray, and outside the main “box” of the form. 

• One-inch top margin to allow for top hole-punching and binding.  
• Header:  

• Top Left of Form: nontinted title box, 4.5” wide, 1.5” high with: 
• Top Left of Box: Small Mercy logo with the dove and word “Mercy”, sized ¼”  (was 

½” but we decreased it to emphasize the form title) high, with 1/16” margin to the 
left and on top 

• Top Right of Box: Words “Mercy Hospital of Pittsburgh” in 10-point Minion (used to be 
15 point but decreased it to emphasize the form title) on two lines, centered, with 
11-point leading, to match the font in the Mercy logo; the text area is 1” wide, 5/16” 
high, with 1/16” margin on top and right. 

• Bottom Center of Box: total text area, exclusive of the logos and hospital name at the 
top, and room for “Page X of U” and “Mandatory” at the bottom, is 15/16” (.9375”) 
high x 4-3/8” (4.375”; 4.5” less two 1/16” margins on either side). Titles of orders 
MUST fit within this space. This text area may include the following:  
• Option: department or unit or physician name, centered, in 12-point Gill Sans 
• Title of orders, centered, in  

18-point bolded Gill Sans  
with 17-point spacing  

• Option: may have subsidiary or alternate title/explanation in smaller print under 
main title, also centered) in [12-point Gill Sans, not bolded, in all lower case 
lettering, on 12-point spacing, also with 12-point separation from the 
above 18-point text]. 

• The title should generally be as short as possible, for legibility and readability, 
and may not exceed the allotted space. 

• Bottom Left of Box: “Page __ of __” in 10.5-point Gill Sans. (Note: moved this from the 
bottom of the page to a more prominent place to make sure that people are aware of 
the number of pages of an order set.) 

• Bottom Right of Box: some orders, especially admitting orders, are required by 
hospital policy. That is to say, it is mandatory that all patients admitted with 
community-acquired pneumonia be admitted using the Community-Acquired 
Pneumonia Standing Orders. Another example that is mandatory but not an 
admitting order is the Department of Emergency Medicine “Brain Attack” orders. 
All such mandatory orders shall have the word Mandatory in 10.5-point Gill Sans 
(baseline lowered by 2 points for proper fit) in the right lower corner of the top box. 

• Top Right of Form: White space for patient imprint and barcode, 1.5” high, 3” wide. 
This space originally was used for a blue-card addressograph stamp, and above it 
was “v Addressograph Here v”. But, with the new FormsFast software that prints 
name and barcode in the upper right of all forms, the “v Addressograph Here v” is 
no longer required, though the white box will remain in the same place and at the 
same size. The original size for the addressograph was 3.5” wide and 2” high but 
this was decreased as the FormsFast imprint does not require as much room. 

• Below Top-left box: gray-tinted the width of the form, ½” high, with instructions. In line 
with current recommendations from forms and medical orders professionals, it will say:  
Draw a line through, initial and date all changes. 
Write "brand necessary" if generically equivalent medication is not acceptabl 
Circles: one and only one. Squares: one, many, or none. 
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It will also show an examples of three radio buttons and three square checkboxes with 
an X inside one of the radio buttons and two of the square checkboxes, to indicate how 
to mark on the form. 

• Signature Block Rules: Medical order signature rules are complex, and can be quite 
confusing. The following principles apply: 
• The signature block will have to appear on every page. Even if the orders are printed 

front and back with a printer that supports duplex printing, a signature block must 
appear on each and every page. This is to ensure that, if the pages are photocopied 
single-sided, a signature box appears on each and every page.   

• Who can sign: 
• Medical students may sign floor (but not DEM) orders; however, these signatures 

must be cosigned by a resident or attending. 
• Residents may sign orders, and do not require attending cosignature. 
• PAs and CRNPs may sign orders, but these DO require an attending cosignature. 
• Admitting orders signed by a DEM resident do not require a DEM attending 

cosignature.  
• Admitting orders signed by a DEM CRNP or PA DO require an attending signature, 

but this can be the admitting attending of record. 
• Admitting orders signed by a DEM attending or resident must either be verified by 

the inpatient attending of record or a covering attending by 9 AM, and rewritten 
within 24 hours. 

• Signature Block Format: 
• According to international forms expert Robert Barnett in his definitive 2005 work, 

Forms for People1, any signature block should be 7/8" high, 2-5/16" wide, with a fine 
dotted line 0.5 points at 2 point spacing, most but not all the way across the box, at 5/8" 
down from the top. This is based on solid evidence from studies of signature blocks, and 
is the best way to ensure that signatures are legible, even on copies of the form. 

• Each signature block will also have a place for date and time, as well as a place for the 
signer’s printed last name. 

• Main Body:  
• The main body of the standing orders will have a left section, 1” wide, which contains 

the names of the sections (10.5 point Gill Sans bold, 10.5 pt leading), and 
explanatory notes in compressed text (10.5 point Gill Condensed Sans, 10 pt leading) as appropriate. 
(1/16” top and left margins for the headings.) 

• Subsidiary sections may be grouped by a box made of a 1 point 25% gray line. 
• Text and Tinting 

• All text will be black, except where text is grayed out as inapplicable.   
• Tinting (grey background): 10% gray.  

• In line with recommendations of Tufte2-4 and others, text originally was on a 12.5% 
grey background, which differentiated from places where the user should write, 
which are white.  
• While not a problem when copying or faxing with the newer Xerox 

multifunction machines, this caused difficulty reading the text when an older fax 
machine or copier was used.  

• Therefore, this was changed into a grid (using the Adobe Illustrator CS2 grid 
tool, which is new in Illustrator CS2 version, and is under the line tool) made 
up of 0.5 point horizontal lines, 25% grey. To make a grid background for the 
9.5” high size of the Standing Orders format, one makes a grid with a line every 
1/32”. This is done by (1) selecting the grid tool, clicking once on the work area, 
entering 7.5 inches wide, 9.5 inches long, 300 horizontal dividers, 0 vertical 
dividers, and pressing “OK.” One must then position the grid appropriately 
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(best on a layer of its own so it can be hidden when editing), and format with 
0.25% grey and 0.5 point size. This results in a gridline every 1/32”.  

• About the time this “grid tinting” was accomplished, we found that all of the old 
fax machines in the hospital were to be replaced with newer multifunction 
devices, making this moot—so the grid was abandoned. 

• Nonetheless, there may be rare occasions where an order set may be faxed to an 
older fax machine (e.g., at another hospital), and certainly they might be copied 
on a photocopier, which makes tinted areas harder to read. 

• Therefore, in line with recommendations from Robert Barnett (in fact, by email 
specifically related to Mercy’s issues with forms), we changed the tint to a less-
intense 10% grey. 

• Exception: the upper left-hand box with the Mercy logo and title will be white to 
make it stand out—it is easy to tell that this is not an area into which one’s 
supposed to write.   

• Most text on a form will be in 10.5 point Gill Sans except as described below. 
• Less-important Text: text tags for less-important items could be in italic—there is a 

temptation to make the write-in boxes for such information slightly tinted 
(crosshatched), too, so that when one’s filling out the forms, one can look at a form and 
see that all the white boxes are filled in, and one can ignore the tinted stuff until there is 
time to deal with it. However, we decided to reserve boxes with tinting (crosshatching) 
inside them for those that simply don’t need to be filled out at all (see below). 

• Dividing Lines Between Sections: Width and type of lines should be consistently used to 
delineate sections and subsections.  The standard will be: 
• Form Borders:   

The borders of the form, and the two top boxes (title and patient ID will be set off by 
thick (1.5 point) black lines  

• Section Dividing lines 
Sections set off by thin (0.75 point) black lines 

• Subsection Grouping:  
When needed, subsections will be grouped by a surrounding 1 point 25% gray box on 
the 10% gray tint backgound, with at least 1/16” margins between the gray box and any 
dividing lines, form borders or other elements.  

• Graying Out: If a part of the standard template doesn’t apply to a particular form, it will be 
grayed out (text in 62.5% grey, and boxes with 10% grey interior and 62.5% grey box 
lines). 

• Footer: 
• Number of Orders (e.g., OS-70 for COPD Standing Orders) and date of revision in 10.5-

point Gill Sans in 65% gray. This will be de-emphasized both being gray, and being 
outside the main “box” but still preserving the 1” bottom margin beyond the 
number/date. 

• Fill-In Boxes 
• General: All places in which the clinician should write shall be in white boxes lined 

with gray lines, on a light gray background. (Barnett argues for black hairlines, Tufte for 
gray borders.1-4 We liked the gray borders better. This may have to do with printing on 
laser printers rather than using offset printing.)  The fillins will be clearly different from 
the text “tags” explaining what’s supposed to go into each box, and from any other text: 
this focuses the user’s attention on the right places.  

• Places that one can fill in will generally be both boxed and surrounded with a rim of 
gray tint/crosshatch. The fill-in boxes will have a rim of at least 1/16” of gray-
tinted/crosshatched area around them, and between them, and between their edges 
and the edges of the surrounding box.     
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• Boxes will be 5/16” high, and boxes that require multiple lines will be in multiples of 
5/16” high, with gray lines at 5/16” intervals. The gray lines will be inset from the left 
and right edges of the box by 1/32”—NOTE that this means that, when resizing boxes, 
the box itself AND the internal lines MUST both be resized separately to preserve the 
1/32” spacing and not stretch it out.  
• Originally, we’d made the forms with 0.2” high boxes for writing, but at a 

Department of Emergency Medicine meeting where the forms were reviewed, 
several physicians suggested that 0.25” high boxes would be better, especially since 
admitting orders may be filled out under time pressure and sleep deprivation. Later, 
we found out that Barnett cites persuasive evidence that these fill-ins should be 
5/16” high, and allow 5.6 characters per inch (4-5 mm/character).  

• Fill-in boxes for single items have descriptive text to the left, with a colon. The text is 
right-justified; it is 10.5-point Gill Sans, vertically centered, or slightly below centered, to 
the box. This is done by making the text area 3/16” high, centered to the fill-in, with the 
baseline lowered by 2 points. Where two lines of text must go with a single-line fill-in 
box, it is 10.5-point Gill Sans with 18-point leading if must match up with the lines, or 11-
point leading if not, vertically centered around the center line of the box or slightly 
below. This will allow the text to fit neatly into the vertical area needed by the box, 
which is 5/16” plus two 1/16” tinted (crosshatched) margins for a total of 7/16”.  If 
desired, a subsidiary explanation may appear under the main text in 9-point Garrison Condensed Sans. 

• For fill-in boxes requiring two or more lines for the fill-in, the box height will be in 
multiples of 5/16”, and there will be 50% gray 0.25-point lines across it at 5/16” 
intervals (with 1/32” spacing between the ends of the line and the border of the box.) 
The text to the left of the box, if multiple-line, is 10.5-point Gill Sans with 11-point 
leading (18-point leading if it is needed to have the text line up with the lines in the 
box), also with a -3 point baseline shift to make it line up with the box properly.  

• Checkboxes are 3/16” x 3/16” (13.5 x 13.5 points).  
• Square checkboxes (ballot boxes) are precisely this size, round checkboxes (radio 

buttons) are slightly larger than this to accommodate the same size X in them, and to be 
visually similar. Originally the checkboxes were 1/8”x1/8" but Barnett1 has evidence 
that they should be larger.  

• There is 1/16” between the box and the text. The surrounding of the box should have 
grey tinting as above.  

• The text for a single checkbox is area text sized to be precisely 3/16”(three of the 1/16” 
grid boxes) high. A baseline shift of -3 points is applied to the text to make it centered 
relative to the checkbox.  

• Pointy Boxes: 
• Where checking a box leads to additional choices, or additional information to enter, 

the checkbox should show a pointy triangle, in effect an arrow. Round and square 
boxes with points are both available in the standard forms symbol library. The point 
may point to the right, or down, depending on where the user’s attention should be 
directed. 

• When appropriate, the additional information to which the user is directed (e.g., 
another set of subsidiary checkboxes) may be grouped with a 1 point 25% gray box 
as described above, under subsection grouping. 

• Columns of checkboxes 
• Columns of boxes are vertically spaced, where appropriate, at 1/4” spacing (1/16” 

between them).  
• Text next to columns of checkboxes is 10.5-point Gill Sans with 18-point default 

leading which makes it vertically spaced the same as the checkboxes. A baseline 
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shift of -3 points is applied to the text to make it centered relative to the 
checkboxes. 

• If two lines of text must be lined up with a single checkbox, it should be on 11 point 
spacing and the vertical spacing of the checkboxes adjusted as needed.  

• Indenting 
• When the form is best formatted with an outline format, for example, nested choices of 

antibiotic combinations, columns of checkboxes may be indented. 
• This indentation may be in a standard outline format as used in text—easily understood 

by users—or can make use of “pointy checkboxes” to direct the user’s attention to 
subsidiary choices. A combination of indents and pointy checkboxes may also be used. 
When there are large chunks of text for each of several options, it is generally best that 
this text be grouped by a box made with a 1-point, 2% gray line, and the checkboxes 
that apply to this box should be vertically centered with respect to the box. 

 
Specific Procedures for using Illustrator to make Standing Orders: 
1. Set units to points, create 1/16” (4.5 point) grid, set grid origin to match physical page 
View > Show Rulers 
Right-click box at top left of rulers, and select Points as the measure for the rulers. 
Use the mouse to drag the box at the top left of rulers to the top left corner of the on-screen 
physical page (sets 0.0 to the physical top left of the page) 
Edit > Preferences > Guide and Grid > 72 points, 16 divisions per grid 
This standard grid allows the use of text point sizes to align with the grid; the following list 
provides the equivalents: 
72 Points 1” 
36 Points ½” 
18 Points ¼” 
11.25 Points 5/32” (for checkboxes) 
9 Points 1/8” 
4.5 Points 1/16” (standard grid) 
2.25 Points 1/32” (for fine adjustments) 
1.125 Points 1/64” (for fine adjustments) 
 
2. Set grid to be visible through the form, and snap items to grid 
View > Overprint Preview 
View > Snap to Grid 
(rarely, should switch to 32 or 64 divisions per grid, i.e., 1/32” or 1/64” spacing, to get the 
checkboxes and text to align; but once aligned, the grid can be switched back 1/16” (16 
divisions per grid) to arrange the grouped checkboxes/text) 
 
3. Wherever possible, use area text instead of point text to allow alignment of text to other 
graphic elements using the bounding box rather than the baseline, and to avoid “rubber text” 
when resizing the bounding box. (Note: in Illustrator, area text cannot be rotated by simply 
rotating the area text container with the Select Tool; however, it can be rotated with the 
Transform Tool.) 
 
5. Symbol Library: an .AI file with a library of common symbols (i.e., checkboxes, radio 
buttons) is available (www.conovers.org/ftp/forms2.ai). When opened (from the Symbol 
Palette), this means you may simply drag and drop these elements where needed on the page.  
 
Note, however that the standard fill-ins will not resize correctly unless you first “break the link” 
between the symbol and the instance you just placed. (For example, if you place a linked single 
fill-in box on the page, then stretch to twice its width, then the grey lines on the beginning and 
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end of the box will stretch to twice the normal width, rather than staying the same width as you 
would expect.) Even though you might be dragging the symbol onto the page from the “forms2” 
Palette, you still have to switch to the Symbols Palette to be able to click on the “break link” 
button. Awkward, and Adobe should fix this, but that’s the way it is right now. 
 
Also, note that the bounding box of a checkbox changes slightly when it is a symbol. It is 
necessary to break the link between the symbol and the instance of it the form so the bounding 
box will be correct for snapping the checkbox to the grid. It is possible to select a symbol in the 
Symbols Palette (not the Forms Symbol Library) and then use the Palette menu to “Select All 
Instances” and then break the link with all instances at once.  
 
6. Centering: Centering text within a form element is easy. Create a text area, enter the text, set 
the paragraph to centered, then widen the text area so its left and right borders match the left 
and right borders of the form element. 
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